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Montserrat Cairó c,d,e,f, Maria Del Mar Gutierrez a,b, Maria Gracia Mateo a,b, Isabel Mur a,b, 
Noemí Corbacho a,b, Joan Carles Domingo c,d, Francesc Villarroya c,d,e,f, Marta Giralt c,d,e,f,* 

a Department of Infectious Diseases, Hospital de la Santa Creu i Sant Pau, Barcelona, Catalonia, Spain 
b Institut de Recerca de l'Hospital de la Santa Creu i Sant Pau, Barcelona, Catalonia, Spain 
c Departament de Bioquímica i Biomedicina Molecular, Facultat de Biologia, Universitat de Barcelona, Barcelona, Catalonia, Spain 
d Institut de Biomedicina (IBUB), Universitat de Barcelona, Barcelona, Catalonia, Spain 
e CIBER Fisiopatología de la Obesidad y Nutrición (CIBEROBN), Instituto de Salud Carlos III, Madrid, Spain 
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A B S T R A C T   

Aims: To assess the potential direct effects of the integrase strand-transfer inhibitors (INsTIs) dolutegravir, bic
tegravir, and raltegravir, drugs used as treatment for people living with human immunodeficiency virus (PLWH), 
on human adipose cells. 
Main methods: Drugs were added to the differentiation medium of human Simpson-Golabi-Behmel syndrome 
(SGBS) adipose cells and morphological adipogenesis was monitored for 10 days. Also, adipocytes were exposed 
to drugs following differentiation (day 14). The gene expression levels of selected adipogenesis markers, 
adipocyte metabolism markers, adipokines, and cytokines were determined by quantitative-reverse transcription 
polymerase-chain reaction. The release of adiponectin and leptin into the culture medium was measured using 
specific enzyme-linked immunosorbent assay, and release of interleukin-6 and chemokine (C–C motif) ligand-2 
using Multiplex assays. 
Key findings: Overall morphological adipogenesis was unaltered by INsTIs. The expression of adipogenesis marker 
genes (peroxisome proliferator-activated receptor-Ɣ and lipoprotein lipase) was slightly reduced in dolutegravir- 
treated differentiating adipocytes. Bictegravir repressed gene expression and the release of pro-inflammatory 
cytokines in differentiating adipocytes. Dolutegravir and raltegravir increased interleukin-6 gene expression, 
but only dolutegravir increased interleukin-6 release. Dolutegravir repressed adiponectin expression and release 
in differentiating adipocytes and had a similar but milder effect on leptin. Drug treatment of mature adipocytes 
reduced adiponectin gene expression in response to dolutegravir. 
Significance: The INsTIs studied do not have a significant effect on human adipose cell differentiation but exert 
distinct effects on gene expression and secretion of adipokines and cytokines. These findings will help understand 
and manage the effects of INsTI-containing treatments on body weight and metabolic dysregulation in PLWH.   
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1. Introduction 

Weight gain and increased adiposity are increasingly found in people 
living with human immunodeficiency virus, HIV (PLWH), contributing 
to an increased risk of serious medical complications. Recent studies 
have raised concerns regarding excess weight gain and metabolic ab
normalities specifically associated with the use of integrase strand- 
transfer inhibitors (INsTIs) for the treatment of PLWH. The first warn
ing came from observational studies, and connections with INsTI treat
ments were later confirmed in randomized clinical trials [1–3]. 
However, the pathophysiological bases of the effects of INsTIs on 
adiposity and the exact contribution of each type of INsTI drug remain 
largely unknown [3,4]. 

Increased body weight, as in obesity, is associated with the 
enlargement of adipose tissue. Adipocytes are key sites of fuel meta
bolism storage (in the form of triglycerides), and energy release in the 
form of free fatty acids in periods of energy demand (such as fasting). 
Additionally, adipocytes are responsible for producing circulating adi
pokines that influence systemic metabolism [5]. Increased adiposity is 
characterized by the enlargement (hypertrophy) of adipocytes and, 
sometimes, even hyperplasic phenomena. Abnormally enlarged adipose 
tissue in obesity is associated with systemic metabolic alterations, 
mainly hyperglycemia, insulin resistance, and dyslipidemia. Concomi
tant with the metabolic alterations in the adipose depots, disturbances of 
adipokines (such as leptin, adiponectin) and cytokines (such as pro- 
inflammatory tumor necrosis factor-alpha (TNFα) and chemokine 
(C–C motif) ligand 2 (CCL2)) secretion by adipose tissue greatly 
contribute to systemic metabolic alterations in overweight and obese 
people [5]. Such conditions have been increasing in PLWH. 

Studies on the effects of anti-retroviral drugs on human adipose cells 
can provide pre-clinical information regarding the potential of these 
drugs to alter adipose tissue. Likewise, these pre-clinical approaches 
have proven useful for identifying molecular targets involved in the 
metabolic side-effects of first-generation anti-retroviral drugs namely 
protease inhibitors and reverse transcriptase inhibitors [6–12]. The ca
pacity of the distinct INsTIs currently used for the treatment of PLWH 
suspected to promote adiposity to directly affect human adipose cells is 
poorly understood. Thus, the goal of the present study was to assess the 
potential direct effects of the INsTIs, dolutegravir (DTG), bictegravir 
(BIC), and raltegravir (RAL), on adipogenic differentiation, relevant 
gene expression, and the release of cytokines and adipokines by human 
adipose cells. 

2. Materials and methods 

2.1. Reagents 

Chemicals and reagents for cell culture were purchased from Sigma- 
Aldrich (St Louis, Missouri, USA). Rosiglitazone which was purchased 
from Alexis Biochemicals (Enzo Life Sciences, Farmingdale, New York, 
USA). DMEM/F12 medium and fetal bovine serum (FBS) were pur
chased from Life Technologies (Carlsbad, California, USA). DTG and 
RAL were obtained from MedChemExpress (Monmouth Junction, NJ 
08852, USA); and BIC was provided by Gilead (Foster City, California, 
USA). For the initial assessments of the effects of anti-retroviral drugs 
before concentration-response analyses, the drugs were used at the 
highest concentrations that did not cause cytotoxicity in specific cell 
systems. The drugs were dissolved using dimethyl sulfoxide (DMSO) as 
the vehicle. Controls included amounts of DMSO (≤0.1 % DMSO of total 
cell medium volume) equal to that used in the drug-treated cells. 

2.2. Human adipocyte cell culture 

To assess the effects of INsTIs on adipogenesis, we used human 
Simpson-Golabi-Behmel syndrome (SGBS) pre-adipocytes. This cell 
strain has been validated as a model of human adipogenic differentiation 

[13] and has been extensively used to assess the effects of anti-retroviral 
drugs on human adipocyte function [14–17]. Human SGBS pre- 
adipocytes were cultured and differentiated into adipocytes, as previ
ously reported [14,18]. Briefly, SGBS pre-adipocytes were maintained in 
DMEM/F12 containing 10 % FBS. After the cells reached confluency, 
adipogenic differentiation was initiated by first incubating the cells for 
seven days in a serum-free medium containing 20 nM insulin, 100 μg/ml 
human apo-transferrin, 0.2 nM triiodothyronine (T3), and 100 nM 
cortisol, supplemented with 25 nM dexamethasone, 500 μM 3-isobutyl- 
methylxanthine, and, 2 μM rosiglitazone to obtain the fully differenti
ated adipocytes or 0.5 μM rosiglitazone (a sub-optimal concentration for 
adipogenic differentiation) for chronic treatments. The cells were sub
sequently switched to an adipogenic differentiation medium containing 
20 nM insulin, 100 μg/ml human apo-transferrin, 0.2 nM triiodothyro
nine (T3), and 100 nM cortisol only and maintained for another three 
days (in the case of chronic treatments) or seven days for treatments in 
fully differentiated adipocytes (where, >90 % of the cells had acquired a 
differentiated adipocyte morphology, as evidenced by lipid droplet 
accumulation). Depending on the experimental design, the cells were 
treated with drugs throughout the 10-day differentiation process or 
acutely for 24 h once they were fully differentiated (14 days after the 
induction of differentiation). 

2.3. Assessment of lipid accumulation in adipocytes 

To assess the effects of these drugs (dolutegravir, raltegravir, and 
bictegravir) on adipocyte differentiation and lipid accumulation, mi
crographs of the cell cultures on day 10 after the induction of differen
tiation were captured using a Motic AE2000 microscope with a Moticam 
5.0 MP camera (Motic Instruments INC, Richmond, BC, Canada). Mi
crographs, as jpg files, were imported into the ImageJ software (Wayne 
Rasband at the National Institutes of Health (NIH)). The image type was 
processed into an RGB stack (Image > Type > RGB-Stack) and a 
montage of the three channels was performed (Image > Stacks > Make 
Montage). Once in the RGB stack, the threshold of the image was 
adjusted (lower threshold of 160 and an upper threshold of 250) (Image 
> Adjust > Threshold). Area, area fraction, limit to threshold, and 
display label parameters were set for measurement (Analyze > Set 
Measurements). Image measurements were then performed (Analyze >
Measure). The measurements obtained were subsequently used for 
comparison. 

2.4. RNA isolation, conventional reverse transcription, and quantitative 
reverse transcription polymerase-chain reaction (qRT-PCR) 

Total RNA was purified from cells using an affinity column-based 
method (Macherey-Nagel; Thermo Fisher Scientific, Waltham, Massa
chusetts, USA) as previously described [14]. Reverse transcription was 
performed in a total volume of 20 μl using random hexamer primers 
(Applied Biosystems; Waltham, Massachusetts, USA) and 0.5 μg total 
RNA. PCR was performed on an ABI/Prism 7700 sequence detector 
system using 20 μl of a reaction mixture containing 1 μl of cDNA, 10 μl 
TaqMan Universal PCR master mix, 250 nM probes, and 900 nM primers 
from an Assays-on-Demand gene expression assay mix (TaqMan; 
Applied Biosystems; Waltham, Massachusetts, USA). The following 
Assay-on-Demand probes from Life Technologies were used: Adipo
nectin, Hs00605917; Chemokine (C–C motif) ligand 2 (CCL2), 
Hs00234140; Cytochrome-c oxidase subunit IV (COX4I1), Hs00266371; 
Interleukin-6 (IL6), Hs00174131; Leptin, Hs00174877; Lipoprotein 
lipase (LPL), Hs00173425; Peroxisome proliferator-activated receptor-Ɣ 
(PPARƔ), Hs00231674; Peroxisome proliferator-activated receptor 
gamma coactivator 1-alpha (PPARGC1A), Hs00173304_m1; Solute 
carrier family 2, facilitated glucose transporter member 1 (GLUT1, 
Slc2a1), Hs00892681_m1; Solute carrier family 2, facilitated glucose 
transporter member 4 (GLUT4, Slc2a4), Hs99999901; RPLP0, 
Hs99999902. Controls without RNA, primers, or reverse transcriptase 
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were included in each set of experiments. The relative amounts of in
dividual mRNAs were calculated using the comparative (2 − ΔCT) 
method and normalized to that of the reference control gene (RPLP0 
mRNA) according to the manufacturer's instructions. Each sample was 
run in duplicates, and the mean value of duplicates was used in the 
calculations. Parallel calculations performed using other reference 
control genes (18S rRNA) yielded essentially the same results. 

2.5. Cytotoxicity assays 

Cytotoxicity was determined using a CytoTox96 kit (Promega; 
Madison, Wisconsin, USA), following the manufacturer's instructions. 
Briefly, cytotoxicity was calculated as the lactate dehydrogenase activity 
present in the cell culture medium relative to the maximum activity 
observed after total cell lysis of cells after exposure to drugs for 24 h. 

2.6. Protein analysis 

Adiponectin, leptin, IL6, and CCL2 (also referred to as monocyte 
chemoattractant protein-1, MCP-1) were quantified using medium 
collected from the last five days of adipocyte culture, before harvest. 
ELISA kits specific for human adiponectin (EZHADP-61 K, Merck Life 
Science; Madison, Wisconsin, USA) and leptin (DLP00, R &D Systems; 
Minneapolis, Minnesota, USA), were used for quantification. IL6 and 
CCL2 levels were quantified using a multiplex analysis system (Lynco 
Research/Merck; Darmstadt, Germany) and a Luminex 100ISv2 instru
ment (Thermo Fisher Scientific, Waltham, Massachusetts, USA). 

2.7. Statistical analyses 

Statistical analyses were performed using GraphPad Prism 9 Soft
ware (San Diego, California USA) using one-way ANOVA and Dunnett's 
multiple comparison test. Significance is indicated in the text (the 
threshold value to determine significance was set to P ≤ 0.05). 

3. Results 

3.1. Pre-adipocytes treatment with INsTIs does not elicit cytotoxicity 

The effects of DTG, RAL, and BIC on the adipogenic differentiation of 
human SGBS pre-adipocytes were tested over a concentration range of 
0.01 to 10 μM, which included the Cmin and Cmax circulating concen
trations as previously reported in treated patients [19,20]. Differenti
ating pre-adipocytes were exposed to DTG, BIC, or RAL (0.01 μM–10 
μM) for 24 h, and the potential cytotoxicity of these drugs at the different 

Table 1 
Effects of dolutegravir (DTG), raltegravir (RAL) and bictegravir (BIC) on SGBS 
human adipogenic differentiation.  

Drug concentration 
(μM) 

0.01 0.1 1 10 

Dolutegravir 99.6 ± 2.3 94.8 ± 3.7 104.8 ±
1.3 

109.5 ±
0.2 

Raltegravir 108.7 ±
0.6 

100.1 ±
0.1 

106.8 ±
3.5 

104.0 ±
1.8 

Bictegravir 106.9 ±
0.3 

101.8 ±
2.6 

109.4 ±
1.2 

109.1 ±
0.6  

Fig. 1. Effects of dolutegravir, raltegravir and bictegravir on adipogenic differentiation of SGBS human pre-adipocytes in culture. SGBS human pre-adipocytes were 
differentiated in culture in the presence of the indicated concentrations of drugs. Treatment was initiated on day 0 and continued throughout the differentiation 
process (10 days). Representative micrographs of adipocyte cell cultures differentiating in the presence of the indicated concentrations of drugs are shown. 
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Fig. 2. Effects of dolutegravir (DTG), ral
tegravir (RAL), and bictegravir (BIC) on the 
expression levels of genes related to adipo
genic function, inflammation, mitochon
drial function, and adipokines in SGBS 
human adipocytes differentiating in culture. 
SGBS human pre-adipocytes were differen
tiated in culture in the presence of the 
indicated concentrations of drugs. Data on 
mRNA levels are presented as means ± SEM 
from 3 to 4 independent cell culture exper
iments, each sample analyzed in duplicate, 
and are expressed relative to values from 
untreated control cells (defined as 1). Sta
tistical analyses were performed using one- 
way ANOVA and Dunnett's multiple com
parison test. *P < 0.05, **P < 0.01, ***P <
0.001, and ****P < 0.0001 for each drug 
treatment vs. control.   
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concentrations was estimated. No significant cytotoxicity was observed 
in the cell cultures exposed to any of the tested concentrations of DTG, 
BIC, or RAL (Supplemental Table 1). This is consistent with previous 
reports, in which DTG and BIC exhibited significant cytotoxicity only at 
higher concentrations (>10 μM) in other cell types (such as hepatocytes, 
fibroblasts, human prostate cells, and hepatocarcinoma cells) [21]. RAL 
showed no cytotoxicity at concentrations up to 10 μM in SGBS pre- 
adipose cells [14,18]. 

3.2. INsTIs did not alter overall adipogenesis but have differential effects 
on adipocyte gene expression 

To study the effects of each drug on adipogenic differentiation, 
INsTIs treatments was initiated on day zero and continued throughout 
the differentiation process (up to 10 days, as described in the previous 
section). The effects of the drugs on the morphological differentiation of 
adipocytes were determined using a phase-contrast microscope and 
Image J software to quantify the cell culture surface occupied by 
differentiated (lipid droplet-containing) cells (see Materials and 
Methods section). Data are expressed as percentages relative to control 
cultures (Table 1). None of the tested drugs had a major effect on the 
acquisition of an adipocyte morphology, as drug-treated cells consis
tently exhibited unaltered lipid accumulation relative to the control 
(Fig. 1 and Table 1). 

Data are expressed as mean ± SEM of the percent of lipid accumu
lation relative to the 100 % adipogenesis elicited by SGBS cultured 
under control (sub-optimal 0.5 μM rosiglitazone-induced adipogenesis) 

adipogenic conditions, as determined by performing phase-contrast 
microscopic imaging and using the Image J software to quantify the 
cell culture surface occupied by differentiated (lipid droplet-containing) 
cells. None of the results was significantly different from control values 
(one-way ANOVA Dunnett's multiple comparisons test). 

Gene expression was quantified after 10 days of the adipogenic dif
ferentiation induction in the presence of INsTIs (Fig. 2). We observed 
little alteration in response to RAL (only a minor induction of IL6 mRNA 
levels), consistent with a previous report [14]. BIC did not alter the 
expression levels of genes encoding adipogenic molecular factors 
(peroxisome proliferator-activated receptor-gamma, PPARγ; lipoprotein 
lipase, LPL), glucose transporter-4 (SLC2A4), glucose transporter-1 
(SLC2A1), or adipokines (leptin, LEP, and adiponectin, ADIPOQ). 
However, BIC significantly reduced the expression levels of genes 
encoding the pro-inflammatory cytokines, CCL2 (MCP-1) and 
interleukin-6 (IL6), at the highest concentration tested (10 μM). DTG 
applied at 10 μM significantly reduced the gene expression levels of 
PPARγ (the master gene regulator of adipogenesis), lipoprotein lipase, 
leptin, and adiponectin (Fig. 2). Considering the release of leptin and 
adiponectin to the adipocyte culture medium, the highest doses of DTG 
mildly reduced the level of released leptin and dramatically decreased 
that of adiponectin; BIC did not alter the release of leptin or adiponectin; 
and RAL had minor effects on these parameters (Fig. 3). DTG signifi
cantly (P ≤ 0.05) increased the release of CCL2 (MCP-1) and IL6 into the 
cell culture medium, whereas BIC reduced the release of both cytokines 
in differentiating adipocytes treated at 10 μM (Fig. 3). RAL had minor 
effects on these parameters. The induction of IL6 mRNA expression was 
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Fig. 3. Effects of dolutegravir (DTG), raltegravir (RAL), and bictegravir (BIC) on the release of CCL2 (MCP-1), interleukin-6, leptin, and adiponectin to the cell 
culture medium of differentiating SGBS human adipocytes. SGBS human pre-adipocytes were differentiated in culture in the presence of the indicated concentrations 
of drugs. Data corresponds to concentrations accumulating in the cell culture medium in the last 5 days of culture. Data are means ± SEM from 3 to 4 independent 
cell culture experiments, and each sample was analyzed in duplicate. Statistical analyses were performed using one-way ANOVA and Dunnett's multiple comparison 
test. *P < 0.05, ***P < 0.001, and ****P < 0.0001 for each drug treatment vs. control. 
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Fig. 4. Effects of dolutegravir (DTG), bic
tegravir (BIC), and raltegravir (RAL) on the 
expression levels of genes related to adipo
genic function, inflammation, mitochondrial 
function, and adipokines in differentiated 
SGBS human adipocytes. SGBS human pre- 
adipocytes were differentiated in culture 
and, on day 14 of differentiation, treated 
with the indicated concentrations of drugs 
for 24 h. Data on mRNA levels are presented 
as means ± SEM from 3 to 4 independent 
experiments and are expressed relative to 
values from untreated control cells (defined 
as 1). *P < 0.05, **P < 0.01, ***P < 0.001, 
and ****P < 0.0001 for each drug treatment 
vs. control.   
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not reflected in the altered IL6 secretion (Fig. 3). 

3.3. Acute effects of INsTIs on human adipocytes 

To test the possible acute effects on already differentiated adipo
cytes, human SGBS pre-adipocytes were cultured and differentiated into 
adipocytes as previously reported and described in the Materials and 
Methods section [18]. When the cells had already acquired an 
adipocyte-like morphology after 14 days of inducing adipogenesis, we 
examined the effects of INsTIs by exposure for 24 h to DTG, BIC, or RAL 
(0.01 μM–10 μM). The tested drugs had minimal effects on the assessed 
gene expression levels (mild induction of LPL expression by RAL and BIC 
at the highest concentrations) except adiponectin (ADIPOQ). Adipo
nectin gene expression was significantly decreased by DTG (P ≤ 0.05) 
(Fig. 4), although this did not result in a significant change in the levels 
of adiponectin secreted into the culture medium by the differentiated 
adipocytes (Supplemental Fig. 1). This may reflect the short duration of 
drug exposure (24 h) used in the experimental setting. 

4. Discussion 

Recent evidence suggests an association between anti-retroviral 
regimens containing INsTIs and increased weight gain in PLWH. This 
weight gain appeared to be greater in DTG and BIC compared to other 
INsTIs. The pathophysiological basis of these effects remains unknown. 

Consistent with previous reports, this study confirms that RAL does 
not exert significant effects on adipogenic differentiation or the levels of 
the tested genes and secreted proteins in human adipocytes [14,22]. 
DTG did not markedly affect the acquisition of adipocyte morphology 
(lipid accumulation), which is also in agreement with a recent report 
using omental and subcutaneous pre-adipocytes [23]. However, we 
discovered that DTG (but not BIC) at the higher tested concentrations 
exerted some inhibitory effects on adipocyte gene expression (such as 
PPARγ and LPL) and markedly reduced adiponectin gene expression and 
secretion in differentiating adipocytes. Gorwood et al. [24] also reported 
a decrease in the expression and release of adiponectin and leptin in 
response to chronic treatment of adipose stem cells (ASCs) with DTG. 
Meanwhile, and valuable in the translatability of these results to pa
tients, González-Cordón et al. [25] have reported hypoadiponectinemia 
in PLWH treated with anti-retroviral patterns that include DTG [25]. 

The downregulation of adiponectin in treated patients might be 
secondary to increased adiposity [26]. However, our observation that 
DTG reduces adiponectin in a cell-autonomous adipocyte system sug
gests a potential direct effect of DTG-based regimens in eliciting hypo
adiponectinemia and subsequent deleterious systemic consequences 
(such as insulin resistance and cardiovascular risk). Notably, we found 
that adiponectin was not significantly altered in adipocytes treated with 
BIC, regardless of the differentiation status or concentration, within the 
tested range. Although some studies have suggested that both DTG- and 
BIC-containing anti-retroviral regimens favor weight gain [3], our data 
suggest that DTG has a stronger action in disturbing the adiponectin 
system in adipocytes. Interestingly, DTG and BIC exhibited opposite 
effects (induction and repression, respectively) on the expression and 
release of the pro-inflammatory cytokine IL6, and partially on the 
expression and release of CCL2 (MCP-1). As adiponectin represses the 
expression of IL6 in adipocytes [27,28], DTG and BIC may elicit alter
ations based on the crosstalk between adiponectin and inflammation in 
adipose tissue. 

Finally, we found a mild trend for DTG to decrease leptin expression 
and release. A recent report showed that leptin levels decreased when 
patients were switched from protease inhibitor-based to INsTI- 
containing anti-retroviral regimes [29]. Moreover, given that the use 
of tenofovir alafenamide (TAF) has also been associated with weight 
gain in PLWH, the combined and synergistic effects of INsTIs and/or TAF 
on human adipocytes require further investigation. 

This study has some limitations associated with its limited capacity 

to translate results obtained in vitro into clinical practice. Moreover, 
besides adipocytes, INsTIs may affect other cell types that are also pre
sent in adipose tissue depots. For example, it has been reported that DTG 
reduces inflammation and senescence in endothelial cells, whereas RAL 
has no effect [30]. However, the significance of the drug concentrations 
used in cell culture studies, even if in the range of circulating levels in 
treated patients, is not unequivocal. DTG has been reported to penetrate 
adipose tissue cells much more strongly than nucleoside/nucleotide 
reverse transcriptase inhibitors [31]. Thus, we speculated that the 
exposure of fat to DTG may be particularly intense in treated patients. 
Comparable information on intra-adipose concentrations of RAL and BIC 
is lacking. Despite these limitations, our in vitro study allowed us to 
establish the direct effects of INsTIs on human adipocytes, which could 
not be distinctly assessed in studies in patients. 

5. Conclusions 

In conclusion, our findings show that INsTIs currently used to treat 
PLWH have differential effects on adipose cells and highlight the po
tential of DTG to repress adiponectin expression/release and enhance 
inflammatory cytokine expression/release. Whereas BIC inhibits pro- 
inflammatory cytokines expression and release. These observations 
may contribute to improving the treatment profiles used in PLWH to 
minimize side effects associated with increased adiposity and metabolic 
alterations. 
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S. Esser, F. Raffi, G. Behrens, A. Pozniak, J.M. Gatell, E. Martínez, NEAT022 Study 
Group. Switching from boosted PIs to dolutegravir decreases soluble CD14 and 
adiponectin in high cardiovascular risk peo-ple living with HIV, J. Antimicrob. 
Chemother. 76 (2380–2393) (2021), https://doi.org/10.1093/jac/dkab158. 

[26] K. Khoramipour, K. Chamari, A.A. Hekmatikar, A. Ziyaiyan, S. Taherkhani, N. 
M. Elguindy, N.L. Bragazzi, Adiponectin: structure, physiological functions, role in 
diseases, and effects of nutrition, Nutrients 13 (2021) 1180, https://doi.org/ 
10.3390/nu13041180. 

[27] E. Zoico, U. Garbin, D. Olioso, G. Mazzali, A.M. Fratta Pasini, V. Di Francesco, 
A. Sepe, L. Cominacini, M. Zamboni, The effects of adiponectin on interleukin-6 
and MCP-1 secretion in lipopolysaccharide-treated 3T3-L1 adipocytes: role of the 
NF-kappaB pathway, Int. J. Mol. Med. 24 (2009) 847–851, https://doi.org/ 
10.3892/ijmm_00000302. 

[28] A.R. Eckard, G.A. McComsey, Weight gain and integrase inhibitors, Curr. Opin. 
Infect. Dis. 33 (2020) 10–19, https://doi.org/10.1097/QCO.0000000000000616. 

[29] L. Calza, V. Colangeli, M. Borderi, S. Coladonato, B. Tazza, I. Bon, M.C. Re, P. Viale, 
Improvement in insulin sensitivity and se-rum leptin concentration after the switch 
from a ritonavir-boosted PI to raltegravir or dolutegravir in non-diabetic HIV- 
infected patients, J. Antimicrob. Chemother. 74 (2019) 731–738, https://doi.org/ 
10.1093/jac/dky507. 

[30] P. Afonso, M. Auclair, M. Caron-Debarle, J. Capeau, Impact of CCR5, integrase and 
protease inhibitors on human endothelial cell function, stress, inflammation and 
senescence, Antivir. Ther. 22 (8) (2017) 645–657, https://doi.org/10.3851/ 
IMP3160. 

[31] J. Couturier, L.C. Winchester, J.W. Suliburk, G.K. Wilkerson, A.T. Podany, 
N. Agarwal, C.Y. Xuan Chua, P.N. Nehete, B.P. Nehete, A. Grattoni, K.J. Sastry, C. 
V. Fletcher, J.E. Lake, A. Balasubramanyam, D.E. Lewis, Adipocytes impair efficacy 
of antiretroviral therapy, Antivir. Res. 154 (2018) 140–148, https://doi.org/ 
10.1016/j.antiviral.2018.04.002. 

P. Domingo et al.                                                                                                                                                                                                                               

http://refhub.elsevier.com/S0024-3205(22)00648-8/rf202209080804592343
http://refhub.elsevier.com/S0024-3205(22)00648-8/rf202209080804592343
https://doi.org/10.1056/NEJMoa1902824
https://doi.org/10.1093/cid/ciz999
https://doi.org/10.1038/s41572-020-0181-1
https://doi.org/10.1007/164_2015_6
https://doi.org/10.1007/164_2015_6
https://doi.org/10.1038/oby.2006.114
https://doi.org/10.1038/oby.2006.114
https://doi.org/10.1055/s-2005-870526
https://doi.org/10.1055/s-2005-870526
https://doi.org/10.1016/j.cmet.2021.07.010
https://doi.org/10.1016/j.antiviral.2011.04.018
https://doi.org/10.1016/j.antiviral.2011.04.018
https://doi.org/10.1016/j.cmet.2021.08.002
https://doi.org/10.1038/s41423-019-0262-9
https://doi.org/10.1159/000145784
https://doi.org/10.1038/sj.ijo.0801520
https://doi.org/10.1016/j.antiviral.2016.05.013
https://doi.org/10.1016/j.antiviral.2016.05.013
https://doi.org/10.1016/j.beem.2010.12.001
https://doi.org/10.1016/j.beem.2010.12.001
https://doi.org/10.1016/j.molmed.2010.03.002
https://doi.org/10.1128/AAC.00104-12
https://doi.org/10.1128/AAC.00029-18
https://doi.org/10.1007/s40262-020-00898-8
https://doi.org/10.1007/s40262-013-0093-2
https://doi.org/10.1007/s40262-013-0093-2
https://doi.org/10.1128/AAC.01474-16
https://doi.org/10.1007/s10156-010-0101-5
http://refhub.elsevier.com/S0024-3205(22)00648-8/rf202209080804578767
http://refhub.elsevier.com/S0024-3205(22)00648-8/rf202209080804578767
http://refhub.elsevier.com/S0024-3205(22)00648-8/rf202209080804578767
http://refhub.elsevier.com/S0024-3205(22)00648-8/rf202209080804578767
https://doi.org/10.1093/cid/ciaa259
https://doi.org/10.1093/jac/dkab158
https://doi.org/10.3390/nu13041180
https://doi.org/10.3390/nu13041180
https://doi.org/10.3892/ijmm_00000302
https://doi.org/10.3892/ijmm_00000302
https://doi.org/10.1097/QCO.0000000000000616
https://doi.org/10.1093/jac/dky507
https://doi.org/10.1093/jac/dky507
https://doi.org/10.3851/IMP3160
https://doi.org/10.3851/IMP3160
https://doi.org/10.1016/j.antiviral.2018.04.002
https://doi.org/10.1016/j.antiviral.2018.04.002

	Differential effects of dolutegravir, bictegravir and raltegravir in adipokines and inflammation markers on human adipocytes
	1 Introduction
	2 Materials and methods
	2.1 Reagents
	2.2 Human adipocyte cell culture
	2.3 Assessment of lipid accumulation in adipocytes
	2.4 RNA isolation, conventional reverse transcription, and quantitative reverse transcription polymerase-chain reaction (qR ...
	2.5 Cytotoxicity assays
	2.6 Protein analysis
	2.7 Statistical analyses

	3 Results
	3.1 Pre-adipocytes treatment with INsTIs does not elicit cytotoxicity
	3.2 INsTIs did not alter overall adipogenesis but have differential effects on adipocyte gene expression
	3.3 Acute effects of INsTIs on human adipocytes

	4 Discussion
	5 Conclusions
	CRediT authorship contribution statement
	Declaration of competing interest
	Acknowledgements
	Appendix A Supplementary data
	References


